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Introduction -M2M/IoT Solution "CONPROSYS"-

CONTEC Professional System

1. A controller that can be used easily

2. Cloud services that can be selected to match the application

3. "HMI software" that can easily be connected to is also provided.

Concept

* The "CONPROSYS" is the result of the technology that we possess at 
CONTEC for creating products!

Cloud server

Controller

It is a product that makes it possible to easily 
construct M2M/IoT solutions!

What is the "CONPROSYS?"

Measurement control
expansion boards Solution technology

Industrial computers Network products
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MEMO



1． M2M/IoT Overview
The Arrival of the Internet of Things Era

M2M/IoT Solution
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1.1. M2M/IoT Overview

Machine to Machine (M2M)
M2M refers to systems in which devices communicate with each other in order to 
perform operations without any participation by human operators. This refers to 
the narrow sense of IoT and can be said to be IoT without human participation.

What is M2M?

Cloud

GW GW

A

S

Mobile circuit (3G/LTE) Ethernet

Measurement Monitoring Control Management

Actuator

Sensor

Gateway

A

A A

A

S S S

S

Internet of Things (IoT)
This is a concept in which not only IT devices such as PCs and servers but all 
things are connected to the Internet.

What is IoT?

Not only people and IT devices but all things are connected to the Internet. 
Consequently, there is a large focus on the added value created by the 
exchange of information between all things.

Sensor Device Person

Internet
VisualizationAnalysis Judgment
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• The "Internet of Things era" in which 50 billion devices are connected to 
each other

• The market created by the "Internet of Things" will grow to an enormous 
size: 4 trillion yen internationally and 250 billion yen just in Japan.

★ Industry trends -the arrival of the Internet of Things (IoT) era-

6.3 billion 6.8 billion 7.2 billion 7.6 billionWorld 
population

0.5 billion 12.5 billion 25 billion 50 billion
Number of 
connected 
devices

0.08 1.84 3.47 6.58
Number of 
devices per 
person

2003 2010 2015 2020

Changes in the Internet era

Year

Items connected 
to the Internet

Computers Devices

 Development of 
communication 
technology

 Spread of cloud 
services

M2M/IoT market changes

0

1

2

3

4

5

2010年 2012年 2014年 2016年 2018年 2020年

国内M2M市場
海外M2M市場
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Source: Cisco IBSG 2011

Source: Yano Research Institute Ltd., 2014

2010 2012 2014 2016 2018 2020

Japanese M2M 
market
International 
M2M market
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Business opportunities hidden in a variety of 
markets
• Unexpected ideas lead to enormous profits.

Organization and project for the promotion of standardization
• oneM2M

This organization aims to standardize M2M. Lately, they have been 
proposing specifications for standardization.

• Industry 4.0
Smart Factory project for the fourth industrial revolution proposed by 
the German government
OPC-UA is positioned as the required communication standard.

★ Industry trends -primary causes of growth-

The M2M/IoT markets are expected to continue 
expanding.

Reduction in the 
cost of 
communication
• The rise of low-cost 3G 

SIM services, etc.

Cloud services
• The spread of 

service provision 
over the Internet

Standard  
unification
• The spread of unified 

standards such as 
Modbus/OPC

• The ability to create systems at a lower price thanks to the 
development of communication and services

• Movements toward the unification of standards in various industries
• The creation of business models even for systems that conventionally 

were not profitable
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1.2. Market Trends
★ Desired results of M2M/IoT

Cloud server
• Centralized 
management

• Storage/analysis
• Remote control

Traffic and moving vehicles

Position 
information

Manufacturing and 
distribution

Operation 
information

Energy

Electric power 
information

Electric power 
information

Health care

Biological 
information

Agriculture

Environmental 
information

• Not simply performing remote I/O or monitoring but providing new 
services and product competitiveness through the application and 
analysis of information obtained from a variety of things

• Optimization of services through the understanding of user trends in 
real time

Regardless of the field, the possibility of increasing 
profits in a variety of markets is hidden in M2M/IoT.
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1.3. Necessary Components of M2M/IoT
★ What is required in order to start IoT?

Device
• Supports 

standards and 
has a flexible 
interface

• Can transmit 
data to the 
host server

Host server
• Collects data 

from devices 
and provides 
assistance in 
analyzing the 
data

Communication 
circuit
• Inexpensive 

while still 
having a speed 
that does not 
hinder 
communication

Security
• Prevents data 

leakage and 
illegal 
operations

CONTEC can provide the CONPROSYS as the foundation of a system required in order to 
start IoT. By concept, the CONPROSYS is simple, convenient, and easy to use. It is the 
optimal solution to use in starting IoT/M2M. Users can construct their optimal M2M/IoT 
business just by applying their ideas and enthusiasm.

With the CONPROSYS, we can easily realize the 
M2M/IoT solutions of our customers.



2． CONPROSYS Overview
"M2M/IoT Solutions" Provided by CONTEC

M2M/IoT Solution
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2.1. CONPROSYS Overview
★ Concept of the CONPROSYS series

Simple, convenient, and easy to use!!

Features
 Enables simple measurement control through intuitive operations
 Provides a multivendor environment through support for industry-standard 

communication methods
 Provides a platform that realizes visualization and remote control
 Provides all the components that are required for M2M/IoT solutions

Functions
 Equipped with a rich variety of interface combinations
 Enables the communication environment required for M2M/IoT solutions through 

simple setup
 Simple expansion of functions through the ability to add and change applications
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CONPROSYS Device Lineup

Easily build an IoT environment
M2M Controller series

Basic and most standard 
series for IoT.
This document explains 
based on this series.

Cloud

Built in software PLC
PAC series

IEC 61131-3 compliant 
PLC programming 
platform is available with 
free download.

Easily connect existing devices with IoT systems
M2M Gateway series

Data collection devices 
that supports multiple 
vendors. Easily collect 
data from PLCs. Machine
models, interfaces and 
protocols can be different.

Cloud
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★ CONPROSYS components

Host server

Measurement Monitoring

Control Management

A

S

Actuator

SensorA

A S

HMI software

(2)

Measured data

(1)(3)

Mobile 
terminal

• Measures data by way of the I/O interface
•Controls actuators by digital/analog/communication I/F
•Transmits captured data to the server by way of an 
Ethernet or 3G circuit

(1) Controller

•Stores the data received from the controller
•The stored data can be viewed from a web browser.
•Provides a host system that matches the application

(2) Host server

•HMI software is installed.
Monitoring screen can be built with browser access only

•Can cooperate with external software using the communication 
function of the controller

(3) HMI software

The CONPROSYS comes with the controller and host server that are required in order to 
construct an M2M/IoT solution. The I/O of a variety of sensors is measured and controlled by 
the controller. The data can be stored on the host server. The CONTEC cloud service can be 
offered by the host server. It can also provide the software information that is required so that 
customers can construct their own cloud services. The host server can also flexibly link with 
the HMI software that has been designed with the purpose of performing measurement and 
control in real time. HMI software is also provided by CONTEC.
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★ CONPROSYS -overview of M2M Controller functions-

2.2. M2M Controller Product Overview

The CONPROSYS M2M controller does not just transfer the data it has collected to the 
host but is also equipped with simple control functions. You can perform control just by 
accessing the controller from a web browser and positioning icons to form a flowchart.
No specialized knowledge of programming languages is required.

• Measurement/monitoring function
You can measure and monitor signals through the controller's built-in interface.

• Simple control function
You can configure simple control settings such as signal I/O, cloud transmission, 
email notification and file save by accessing the controller from a web browser and 
using the GUI to form a flowchart.

• Data transfer function
The collected data is periodically transferred over HTTP or HTTPS.
In addition, FTP data transmission is supported (Ver.2.5.0 or later.)

• User account management
You can manage each user’s role by choosing from “Admin”, “User” and “Guest”.

• Modbus slave function
You can acquire the controller status information from an external device over 
Modbus/TCP.

• OPC-UA function
We offer models that features OPC-UA Server and MTConnect function.

• CNC cooperation function
Receiving and data management of external output command (DPRNT command) 

output data from CNC via serial communication. (Ver.2.3.0 OPC UA server installed 
models only)

• Conventional development environment
The remote I/O communication protocol "F&eIT," which CONTEC has conventionally 
provided to our customers, is supported. You can use previously constructed 
systems without any adjustments.
You can also use "API-TOOL," which CONTEC has conventionally provided to our 
customers.

Controller functions
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★ M2M controller functions -simple control functions-

 I/O can be set easily.
 Control rules can be set easily by way of flowcharts.

Task edit function

[Features]
• Settings can be configured from a web browser.
• Position control components on the chart to define 

rules.
• A rich variety of control components (such as time 

synchronization, comparison, and calculation) are 
available.

• 1 task is managed on 1 page.
• Up to 10 main tasks and 10 sub tasks can be 

managed.

 Simple monitoring screens can be created.
 These screens can be created just by positioning components on the screen 

and setting the display data.

Monitoring function

[Features]
• Settings can be configured and the display can be 

viewed from a web browser.
• Users create screens by arranging display 

components on the screen.
• A rich variety of display components (such as 

meters and graphs) are available.
• Up to 20 screens can be created.

* All that can be controlled is the I/O of the 
controller itself.

Simple control is possible just with the controller unit. Simple control can be set and monitoring 
screens can be created by accessing the controller through a web browser and using drag-
and-drop operations to create flowcharts.

Connecting to a 
CONPROSYS device from a 
web browser

A

S

Actuator

SensorA

A S

Just by using browser operations, it is possible to perform 
calculations and control simply. There is no need for dedicated 
programming knowledge or a development environment.

Email notification
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This function periodically transfers measured data.
You can select HTTP or HTTPS for the transfer method.

★M2M controller functions -data transfer function-

Host system

Data transmission function

Flexible transmission method according to the application.

Automatic transmission by setting server URL and interval is 
possible. In addition, raw and processed data can be sent in 
free format with Task Scripting function.

Azure IoT Compliant
Supports FTP

HTTP
or

HTTPS

Other data transmission functions
・Collaboration with Microsoft Azure
Corresponding to the "Azure IoT" provided by Microsoft.

・FTP transmission function
FTP Client feature on board. Transmission of measured data and 

acquiring setting file from host are available.
・Direct communication with partner’s cloud system (Optional)
Supports HULFT IoT provided by Saison Information Systems.
Supports FUJITSU Cloud Service K5 IoT Platform.

SW

Flow
 

m
eter

Solenoid 
valve

Sw
itch

SW

Flow
 

m
eter

Solenoid 
valve

Sw
itch

SW

Flow
 

m
eter

Solenoid 
valve

Sw
itch

Measured 
data

Measured 
data

Measured 
data
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★M2M controller functions –user management function-
You can manage each accessing user’s role by choosing from 
“Admin”, “User” and “Guest”.

User management function

Login password can be disabled.
By disabling the "login password" setting on the user setting menu, 
it is possible to omit the password input at login.

Only Status 
menu items 
are available.

All maintenance 
setting including 
user management 
is possible.

User Name : XXXX
Password   : xxxxx

User Name : YYYY
Password   : yyyyy

Guest Administrator 

CONPROSYS Menu screen differs 
for each user’s access rights.

User

User Name : ZZZZ
Password   : zzzzz

Possible to 
access Status 
and Setting 
menu
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★ M2M controller functions -Modbus slave function-

Remote I/O with PC control
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Remote I/O with a PLC
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Control PC PLC

* This is limited to those 
PLCs that support 
Modbus/TCP.

• It is a memory-access-type communication protocol.
• It is widely used in SCADA systems and other aspects of the FA industry.
• It is an extremely simple protocol and its specifications are public.

■ Image of communication

In Modbus communication, the master issues a variety of commands, and the 
slave returns responses to these commands. The CONPROSYS acts as the slave 
and returns its acquired information, the results of calculations, and other similar 
responses to the requests for data from the master.

Measuring equipment
Host communication device 

(Modbus master)

Ethernet

Modbus
Data request

Modbus

The slave returns its acquired information 
or the results of calculations in response to 
requests for data. In the event of a write 
instruction, the corresponding part of 
memory is changed to the specified value.

Data response
SCADA system, 

etc.

■ What is Modbus?

A

S

Actuator

Sensor

S
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★ M2M controller functions –OPC UA server function-

・A type of communication protocol widely used for SCADA 
and others.
・OPC UA model can communicate with host systems via OPC 
UA.

■What is OPC UA?

OPC UA Communication

★Line up model with MTConnect Adapter & Agent
■What is MTConnect?
Communication protocol for machine tool defined by MTConnect
association.
It is adopted by machine tool manufacturers mainly in the United States.
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★ M2M controller functions –CNC Collaboration function-

• CONPROSYS can receive serial communication data output from CNC by 
external output command (DPRINT) and manage the data.
(Ver.2.3.0 OPC UA server models)

• By using OPC UA, MTConnect and Modbus protocol, CONPROSYS can 
deliver captured data to external systems.

■CNC communication support (FANUC and others)

CNC Coolaboration function

CN
C

co
m

m
un

ic
at

io
n

(S
er

ia
l c

om
m

un
ic

at
io

n)

CONPROSYS
M2M controller

Monitoring system
(SCADA or others)

OPC UA、MTConnect、Modbus

Machine tool with old type CNC

External output 
command(DPRNT)

O1234;
POPEN;
DPRNT[PN*PARTS1];
PCLOS;
G92 X0. Y0. Z0.;
G91 G00 X10. Y20. 
Z30.;
：

NC program

Ethernet
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★ M2M controller functions -using as a Linux box with Linux SDK-

The CONPROSYS can also be used as a Linux box equipped with an I/O 
interface. CONTEC releases the information required to develop applications. 
In addition, we have also prepared an API for using the I/O interface.

Linux SDK outline

Actuator

Sensor A

S
S

Development tools works 
on the CONPROSYS include;
・Linux source code
・Various sample programs
・Build / SD writing tool

Hardware
Interface

API, LinuxOS

User Application

Both SD boot and internal ROM boot are 
possible to develop. 

Cross Development with SDK

Building• Software Module
• Source Code

CONPROSYS※1

Boot
section

SD
Image

rootfs
section Writing

Building Tool Writing Tool

Monitoring Tool

Monitoring

SDK SCOPE

• Boot SD
• Firmware

Writing SD

Host PC※1

Provided as iso
file format.

Serial Cable ※1

* Self-development on the CONPROSYS is available, but limited to Ubuntu 14.04.
* Please prepare development devices such as PC, cables, SD card and CONPROSYS 

by yourself. For more details, please visit our website.

SD Card※1
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★ CONPROSYS -hardware overview-

• These controllers are small and compact and can be installed on a DIN rail.
• A CPU for embedded devices is used, which conserves electric power.
• Parts with short service lives have been eliminated from the design, which 

provides high reliability and reduces the frequency of maintenance.
• The operating temperature range is -20 to 60°C (-4 to 140°F), which enables 

these controllers to be used in any and all fields.
• These controllers are equipped with two LAN ports, which enables LAN 

transition wiring.
• A model that supports 3G communication and a model that supports 920 MHz 

are also available.

Features

The CONPROSYS is available in two hardware configurations. The standalone controller 
is equipped with all the general-purpose functions in one single device. The stack 
controller has excellent expandability and can be used to construct an interface that 
meets the needs of the customer.

Standalone controller Stack controller

Ethernet

All-in-one model that have 
various functions in a 
compact body.

Flexible configuration
Exchangeable even with 
DIN mounted
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★CONPROSYS – Wireless communications -

3G mobile communication

Mobile network

Cloud Server

Internet
CONPROSYS 3G model

Data transmission 
via 3G network

Send measured data to cloud server via 3G mobile network.

Wireless LAN feature

Cloud Server

Internet

CONPROSYS

Data transmission 
via wireless LAN

Wireless LAN connection is possible by using 
a USB adaptor.

Access point
* Image

By connecting a specific vendor's USB wireless LAN device to the USB 
port, it is possible to use the wireless LAN connection.
* Please refer to the software manual for corresponding models.

Supports 
wireless LAN

CONPROSYS offers models compatible with wireless communication of 3G mobile 
network / 920 MHz local radio in addition to LAN. Each feature is shown below.
Wireless LAN connection is also possible by connecting a specific adapter to the 
USB port.
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★CONPROSYS – Wireless communications -

920MHz model  (Japan only)
It is possible to connect multiple slave CONPROSYS units by 920MHz 
wireless communication. Simple multi-hop communication enables 
wide area deployment.

Cloud server or others

Slave unit

Slave unit

Slave unit

By relay settings, the unit transfer the data 
of a slave unit apart from the master unit.

Master unit

Send data via master 
unit by wired network

Supports Wireless remote I/O terminals (Japan only)
By using 920MHz model as a master unit, signal data 
collection from CONTEC’s Wireless I/O Terminals is 
possible.

Cloud server or others

Master unit

Capture measured 
data from Wireless 
I/O terminals

Slave unit

Slave unit

Wireless Digital I/O Terminal
DIO-0404LY-WQ

Wireless Analog Input Terminal
AI-1004LY-WQ

Ver.3.0.0
Supports 

Wireless I/O

* For models outside Japan, please contact to our sales offices in your region.

* For models outside Japan, please contact to our sales offices in your region.
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★ CONPROSYS -host server overview-
2.3. Host server overview

The CONPROSYS host server enables the storage and simple visualization of data.
Two different services are available and can be selected depending on the customer's 
application: a service in which we provide the customer with a cloud managed by CONTEC 
and a service in which we provide the customer with server software setup information.

■ Host server model
(1) On-premises model

With this service, the terminals provided by the customer are used to store and 
provide a simple display of the data.
This service is constructed with open-source software, so CONTEC provides the 
customer with setup information.

Local server
 CONTEC provides the customer with 

setup information.
 The customer sets the server software.

(2) Cloud model
With this service, the customer uses a cloud managed by CONTEC.
A 3-month free trial is available.

 The customer accesses a cloud 
managed by CONTEC.

CONTEC 
cloud service

Internet

We have released the data transmission layout to the public. 
It is also possible for the customer to prepare the server 
software.
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The CONPROSYS host server registers and stores the data files that it receives from the 
controller in a database. The stored data can be viewed from a web browser.

• Graph screen

• Top monitor screen

• Data list screen

• Unit selection screen

★ CONPROSYS – Cloud Data Service functions -

・Data storage functions
Capture CSV data and store the data in the database.

・Data processing functions
Possible to process and manage the data from controller.

・Simple visualization functions
Display stored data in table or graph format.

・Alarm functions
By setting threshold level, sending an alarm mail and saving error history is 

possible.

・User management functions
User  management of Administrator / User / Guest IDs and passwords is possible.

Host server functions

■Host server screens (image)



28

2.4. Configuration examples
★ Examples of systems using the CONPROSYS

■Proof of Concept in our own factory
Introduced IoT system based on CONPROSYS in our own factory.
Based on the knowledge cultivated at the site, we will offer better IoT solution 
to customers. We are also verifying visualization using not only our own Cloud 
service but also Microsoft Azure.

Board production Static electricity

Work environment

Temp.

Humid.

Soldering iron

Iron tip 
temp.

Charge

Produc
tion

Screw driver

Torque

Capacity utilization

In work

Moisture-proof storage

Temp. Humid.

Power consumption

kW

IoT for manner IoT for 
environmentIoT for qualityIoT for process

Visualization screen

CONPROSYS 
Cloud Microsoft

Azure
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■Usage at a plant factory unit
An application example at a plant factory that is becoming popular in recent years. Various 
signals are measured by the CONPROSYS controller and we provide visualization on our Cloud 
server.

Water 
proces

sing

Water

Heating

Electricity

CO2

Light 
Control

Temp / humid 
Control

CO2
control

Fertilizer 
control

CO2 sensor

Illuminance

Temperature

Humidity

Home / Office
・Parameter Settings
・Remote control
・Cultivation planning Remote 

Monitoring

Visualization screen

Climate controller
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■Usage as an alarm monitoring unit
Monitor operations in the facilities and control necessary information such as 
production/quality/equipment for implementation of the IT system.
Moreover, onboard simple controlling function enables to use as an alarm 
monitoring unit.

Plant facilities

Collect info
of operating 
condition 

Controller

Facilities management server

Plant facilities

Controller

Configurations

Facilites
condition

Operation 
times

Error 
information

By analyzing operation time, 
calculate the capacity utilization rate.

By analyzing operation frequency, 
predict the time of parts exchange.

By analyzing error history, find  and 
examine potential problems

Output signals upon 
detecting an error

Collect info
of operating 
condition 
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■Operation monitoring of manufacturing facilities (M2M Gateway)

Communicate with the PLC of the production facility, collect operation 
information and send it to the cloud server.
An example of operation information management in the cloud system.
Multiple PLC communication is possible with one M2M Gateway. It is also 
possible to deal with different PLC manufacturers and communication interface.

Configurations
Cloud server

M2M Gateway

Watt hour meter

Ethernet

Facility A
PLC vendor：A
Ethernet
communication

Facility B
PLC vendor：B
Ethernet
communication

Facility C
PLC vendor：A
Serial 
communication

Serial communication

MODBUS master function is 
also installed. Can be used 
as a power measurement 
of equipment. 

Monitor data
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■ Usage as an M2M controller embedded in an industrial 
storage battery system
The CONPROSYS is provided as a Linux controller. CONTEC releases the Linux OS 
information, which enables customers to develop applications. The CONPROSYS can 
be used as the EMU (Energy Management Unit) for industrial storage battery systems.

(1) Built-in CAN interface
(2) Control program created by the 

customer
(3) Linux OS information released by 

CONTEC

Details

[CONPROSYS 
appearance]

SIM SLOT

3G

12 to 24 
VDC

RS-422/485DI/CNT/DOLAN1

RS-232CSD CARD
SLOT

LAN2 AI

USB

RS-485 
communication

CAN 
communication

Electricity 
storage system

Applications developed 
by customers



3. Configuring CONPROSYS Settings

M2M/IoT Solution
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Preparation

・Environment setting to display

・Network connection between PC and controller

・Network setting of PC

★Displaying CONPROSYS setting screen
3.1. Operation outline

Setting and monitoring of CONPROSYS is proceeded through Web 
browser of PC or smart device.

Varied 
functionality

・Display setting screen of controller
Display 
screen

・Monitoring (HMI)

・Visual Task Control (VTC)

・Data transmission

・Network setting

・System setting
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A Web browser is used for editing of monitoring screen and setting of the controller.
We recommend the following for the browser environment for access.
Please prepare as necessary.

Preparation

・Environment setting to display

・Network connection between PC and controller

・Network setting of PC

Item Specification

Supported browser (Windows*)
Google Chrome 47 or later
Mozilla Firefox 42 or later
Microsoft Internet Explorer 11
*Windows 7 or later

Item Specification

Supported browser (Windows*)
Google Chrome 47 or later
Mozilla Firefox 42 or later
Microsoft Internet Explorer 11
*Windows 7 or later

Supported browser (Android) Google Chrome 47 or later

Supported browser (iOS) Safari 8 or later

(1) Edit operation : Editing monitoring screen (HMI) and task scripting (VTC)

(2) Displaying : Monitoring screen

3.2. Preparation
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3.2. Preparations before Setup

Use a web browser to set and view the controller.
Before you configure the settings, you have to prepare a network connection.

■LAN cable connection

LAN cable (straight)

Connect the controller and the PC by straight cable.

・Network setting of PC
Set IP address and network mask of PC for network connection with the controller.

IP address：10.1.1.101
(Factory default)

Controller

PC

Network setting detail
Set addresses as below.

IP address ：10.1.1.200

PC Controller

Relationship of IP setting between PC and controller is as below.
About IP address setting

Preparation

・Environment setting to display

・Network connection between PC and controller

・Network setting of PC

IP address: 10. 1. 1. 101
Subnet mask: 255.255.255.0

IP address: 10. 1. 1.  200
Subnet mask: 255.255.255.0

Set these to the same numbers.

Set these to different numbers.

Setup PC Controller
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★ Setting the IP address

Open the "Network and Sharing Center" from Control Panel.

If Control Panel is in Category View, open "Network and Internet."

Click "Network and Sharing Center" under 
"Network and Internet."

Click "Change adapter settings" in the left menu.

Double-click the "Local Area Connection" icon.

* The figures are from Windows 7.

This section explains the procedure to follow to set the setup PC's IP address to 
192.168.1.200.
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The "Local Area Connection Properties" dialog box opens.
Double-click "Internet Protocol Version 4 (TCP/IPv4)."

The "Internet Protocol Version 4 (TCP/IP) Properties" dialog box opens. Change 
the settings to match the following figure. (Set the IP to 192.168.1.200.)

Click here when you finish 
configuring the settings.

* Make a note of the original settings if you expect that you 
will have to return them to their previous values.

192 . 168 . 1 . 200
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3.3. Displaying the Setup and Monitoring Screens
Start Internet Explorer.
Type the CONPROSYS IP address in the address bar, and then press the 
"Enter" key to access the CONPROSYS.

If the webpage is not displayed
If the webpage is not displayed, check the following item.
• Proxy settings are configured in the web browser.

→ Temporarily disable the settings or register an exception.

When you access the CONPROSYS, an authentication screen is displayed.

10.1.1.101

When the authentication screen is displayed, 
use the following information to log on.
User name: mc341
Password: mc341

If the browser complains 
website security issue, click 
“More information” to show 
detail, and click “Go on to the 
webpage (not recommended)”
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★Menu list
When login as an Administrator, menu items below is displayed.

*The menu screen differs depending on 
the firmware version and model (installed 
function).
The firmware version is shown on the 
upper right corner of the web screen.
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3.4. Monitoring function (CONPROSYS HMI)

★Display Monitoring edit screen

(1) Click “Monitoring Edit” in the menu.

(2) Monitoring edit screen is shown in a new tab.

Monitoring view shows / operates measured and processed 
values by the controller. To create a Display Monitoring screens, 
click “Monitoring Edit” to launch Monitoring edit screen.

The screen above is the image when creating the monitoring screen.
The factory default setting is a white background.

Menu bar area

Property area

Layer area

Display control 
items area

Variables link area

JavaScript area

If the dialog box below appears, check off 
the square box at the bottom, then click the 
“Run” to start the application.
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★Outline of monitoring functions
In monitoring editing, you can create a screen that monitors the state of the signals 
input side by side. Also, depending on the item you can change the digital signal 
output and TAG number.

Operation TAG

Monitoring Interfaces of controller

Tags

You can arrange prepared items and create the following monitoring screen.
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The CONPROSYS controller has a monitoring function that displays the 
measured and processed values and a scripting function that performs 
calculations on measured values and performs simple control. In the 
scripting function, you use variables known as TAGs to perform calculations 
and control. You can also display TAG values calculated with the scripting 
function on the monitoring screen.

TAG data

I/O interfaces

・Create simple control function

Scripting function

・Monitor / operate measured value
・Create monitoring display screen

Monitoring function

★ What is TAG data?

Viewing CONPROSYS 
controller via Web browser

A

S

Actuator

Sensor

Digital signals
Pulse signals
Analog signals etc.

TAG00 TAG is like a box contains a data.
Current analog value

Monitor input value
Control output value

TAG00 TAG01 TAG99・・・

Monitor TAG data
Control TAG data

Read / write 
TAG data

Capture values and 
Control of each interfaces
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Icon Name Item appearance Description 

Label This control displays a string. You can display arbitrary text, 
numerical value of TAG, numerical value of input signal.

Border
This control is a border with a title. The title can display 
arbitrary text, numerical value of TAG, numerical value of 
input signal.

Image This control displays an image. If you upload the image into 
the controller, you can use the best image for the system.

Switch

This control is a switch that can output an ON/OFF status. 
Part of the button color can be changed. By setting the 
output, ON / OFF operation can be performed from the 
screen during application execution.

Lamp This control is a lamp that can display an ON/OFF status. 
You can change the color.

Checkbox
This control is a checkbox that can output an ON/OFF status 
and display a string. You can manually turn ON / OFF 
switching etc. like the switch during application execution.

Radio 
Button

This control is a radio button that allows a single condition to 
be selected from multiple conditions. You can switch 
exclusively with multiple radio buttons grouped. You can 
operate from the screen during application execution.

Button

This control is a clickable button that displays a text string. 
Unlike the switch, ON / OFF state change occurs only at the 
moment the button is pressed. You can press the button 
while the application is running.

Text Input
This control is used to input and display text. Unlike labels, 
you can enter and edit character strings during application 
execution.

Slider

This control is used to output data with a slider. You can 
move the slider during application execution to display the 
value. You can also display the numerical value of the TAG 
and the numerical value of the input signal.

Video
This control is used to play videos. 
The type of video that can be played depends on the 
browser.

★Item type and function
The following items are prepared with the monitoring function.
You can combine these items to create a monitoring screen.

http://data.conprosys.com/help/hmi/v1/en/102_control_label.html
http://data.conprosys.com/help/hmi/v1/en/103_control_border.html
http://data.conprosys.com/help/hmi/v1/en/104_control_image.html
http://data.conprosys.com/help/hmi/v1/en/105_control_switch.html
http://data.conprosys.com/help/hmi/v1/en/106_control_lamp.html
http://data.conprosys.com/help/hmi/v1/en/107_control_checkbox.html
http://data.conprosys.com/help/hmi/v1/en/108_control_radiobutton.html
http://data.conprosys.com/help/hmi/v1/en/109_control_button.html
http://data.conprosys.com/help/hmi/v1/en/10a_control_textinput.html
http://data.conprosys.com/help/hmi/v1/en/10b_control_slider.html
http://data.conprosys.com/help/hmi/v1/en/10c_control_video.html
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Icon Name Item appearance Description 

Trend This control is used to display chronological data as a 
graph. 

Circle Meter This control is used to display data as a circle meter. 

Level Meter This control is used to display data as a level meter. 

Circle 
Graph This control is used to display data as a circle graph. 

Trend Bar This control is used to display data as trend lines or 
bars.

OnDelay
Switch

This control is a switch that can output an ON/OFF 
status after being pressed in specified seconds.

Multiple 
State Lamp

This control is a lamp that can display multiple values of 
differing statuses. 

Tab This control is used to create multiple tabs that can be 
displayed by switching.

Table This control is used to display data by a table.

Html frame This control is used to display another Html document in 
the frame.

List This control is used to display data by a list.

http://data.conprosys.com/help/hmi/v1/en/10d_control_trend.html
http://data.conprosys.com/help/hmi/v1/en/10e_control_meter.html
http://data.conprosys.com/help/hmi/v1/en/10f_control_levelmeter.html
http://data.conprosys.com/help/hmi/v1/en/10h_control_circlegraph.html
http://data.conprosys.com/help/hmi/v1/en/10i_control_trendbar.html
http://data.conprosys.com/help/hmi/v1/en/10j_control_odswitch.html
http://data.conprosys.com/help/hmi/v1/en/10k_control_mslamp.html
http://data.conprosys.com/help/hmi/v1/en/10l_control_tabs.html
http://data.conprosys.com/help/hmi/v1/en/10m_control_table.html
http://data.conprosys.com/help/hmi/v1/en/10o_control_html.html
http://data.conprosys.com/help/hmi/v1/en/10s_control_list.html
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Icon Name Item appearance Description 

Timer
This control is used to keep counting between 
the maximum value and the minimum value 
periodically.

Calendar This control is used to display and set the 
date.

Clock This control is used to display the current 
time.

Drop-down 
List

This control is used to display the value in 
drop-down list format.

Keyboard This control is used to display and inputs the 
value in software keyboard format.

Number to 
Color

This control is used to convert a number to a 
color string.

Number to 
Bits

This control is used to convert numbers and 
binary values.

http://data.conprosys.com/help/hmi/v1/en/10t_control_timer.html
http://data.conprosys.com/help/hmi/v1/en/10u_control_calendar.html
http://data.conprosys.com/help/hmi/v1/en/10v_control_clock.html
http://data.conprosys.com/help/hmi/v1/en/10w_control_ddlist.html
http://data.conprosys.com/help/hmi/v1/en/10z_control_keyboard.html
http://data.conprosys.com/help/hmi/v1/en/10x_control_colorconversion.html
http://data.conprosys.com/help/hmi/v1/en/10y_control_bitconversion.html
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Icon Name Item appearance Description 

Line This control is used to draw a line on the 
page. 

Polyline This control is used to draw a polyline on the 
page. 

Bezier 
Curve

This control is used to draw a Bezier curve 
on the page. 

Rectangle This control is used to draw a rectangle on 
the page. 

Round 
Rectangle

This control is used to draw a rounded 
rectangle on the page. 

Polygon This control is used to draw a polygon on the 
page. 

Ellipse This control is used to draw a circle or ellipse 
on the page. 

Pipe This control is used to draw a pipe-style 
continuous line on the page.

http://data.conprosys.com/help/hmi/v1/en/10ga_draw_line.html
http://data.conprosys.com/help/hmi/v1/en/10gb_draw_polyline.html
http://data.conprosys.com/help/hmi/v1/en/10gc_draw_curve.html
http://data.conprosys.com/help/hmi/v1/en/10gd_draw_rect.html
http://data.conprosys.com/help/hmi/v1/en/10ge_draw_rrect.html
http://data.conprosys.com/help/hmi/v1/en/10gf_draw_polygon.html
http://data.conprosys.com/help/hmi/v1/en/10gg_draw_ellipse.html
http://data.conprosys.com/help/hmi/v1/en/10gh_draw_pipeline.html
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★Basic operation

Select an ‘Item’ displayed in a tree style ‘Display 
Control’ list, and place it in Layer area. 

Click or drop at the place where you 
place items on the screen.

Click

■Add an item

Click to select
or

Drag & drop



49

★Basic operation

Click item in Layer area to be selected, shown in a blue frame.

Possible item operation list will be displayed by right click.

Undo ：[Ctrl]+[Z]
Redo ：[Ctrl]+[Y]
Delete ：[Delete]
Copy ：[Ctrl]+[C]
Paste ：[Ctrl]+[V]

To move item, please drag the blue frame and drop.

Click to select

Some operations are possible by shortcut keys.

‘Undo’ and ‘Redo’ can be performed without 
item selection.

■Edit an item

■Move an item
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By selecting an item, the settings are displayed in Property area.
When the item is Label, there is a setting named Text. To change 
the string, modify the Value.
To assign value of Digital input, Analog input or a TAG of the 
controller, select setting item and click Device Tree icon    and 
select the device data.

Example: Assign an Analog input value (AI0) to a label.

Click
1. Select Text

2. Click to display Device Tree.
When clicking Link column of 
Text, same icon is appeared.

Click

Click

3. Select AI0 
and click OK

■Setting of items



51

Value : The image and string that will be displayed 
are determined by this value.
For Lamp, it is binary of false / true.

imgOff : Specify item image in case of false.
imgOn : Specify item image in case of true.
TextOff : Specify text string in case of false.
TextOn : Specify text string in case of true. 
TextOffColor : Specify text color in case of false. 
TextOnColor : Specify text color in case of true. 
Font : Set font property of the text on the item.
x : Set horizontal location offset of the item.
y : Set vertical location offset of the item.
width : Specify width of the item.
height : Specify height of the item.
visible : Specify item visibility.
angle : Specify rotation angular of the item.
rotation center : Set center position of rotation.
skew : Specify inclination of the display control.

Available properties depend on the item.

Example: Setting items of ‘Lamp’

Following setting items are available for a Lamp.

Some setting item shows a dialog box to select a file.
In case of imgOff, by clicking Value column the dialog below is 
displayed to select an image.

Click

You can upload any images 
required for your display screen.
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By clicking the gear icon in Property area, you can set optional 
setting items of each display item.
You can change optional settings for each item, such as changing 
the color / scale of characters.

* The setting items are different depending on the item.

■Option settings of an item
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(1) Save operation of a monitoring screen

(2) Save the settings to ROM

Please [Save the settings to ROM] securely.
If you reboot or shutdown the controller without [Save the settings to ROM] 
operation, the changes will be lost. [Save page] [Save page as..] is 
temporary saving during power on of the controller.
You can save to ROM by [Exit] -> [Save] in menu page.

Save your settings to ROM by [File] -> [Save the settings to ROM].

Without this operation, rebooting or power off will discard the 
changes and the controller runs with the former settings. 

If you move to the other screen without saving the page, the setting will be lost. 

[Save page]
Overwrite current page.

[Save page as ...]
Save the page with new name.

Please save the screen by [File] -> [Save page] or [Save page as...].

■Save a screen
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Multi Input and Output model of integrated Controller has devices below.

Signal type Device name

Digital Input 0 DI00
Digital Input 1 DI01
Digital Input 2 DI02
Digital Input 3 DI03
Analog Input 0 AI0
Analog Input 1 AI1
Counter Input 0 CNT0
Counter Input 1 CNT1

* Counter Inputs share with Digital Input 2 and 3.

Signal input

Signal Output
Signal type Device name

Digital Output 0 DO00
Digital Output 1 DO01

★About devices on a controller

To view device information, click [View] -> [Device Tree...].
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This is the way to monitor a digital input by Lamp.
Place Lamp by drag and drop.

★Example 1 : Monitoring signals of a controller

The setting items is shown in Property area by clicking the Lamp.

Assign corresponding device by clicking Link column of [value].

Open Device Tree by clicking the left icon.

Name of digital input signals start from DI.
Select the device you want to link, and click OK.
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Checking digital input signal and monitoring screen

Digital signal input

ON

Input a digital signal and confirm changes in the monitoring screen

Set to on the digital input, and confirm the Lamp becomes ON.

Reference: How to connect digital signals

0 1 2 3 MCOMNC
DI/CNT

A switch or others

Connect a switch or others as shown left.

OFF ON

You can change images when switch is ON and OFF.
By clicking [Value] column, image select dialog will be appear. 
You can change it into another image.

Other setting items
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Place a Switch and select it.

★Example 2 : Output signal operation
In the Monitoring screen, the other operations in addition to signal 
monitoring.

Connections

Connect external power supply 
and a lamp as shown left.

ー ＋ ー＋
DO0

Lamp

DO1

Power supply
24V

Rated maximum output 
voltage and current are 
24V/200mA per channel.

Assign a device in the [Link] column of [value] as in the example 1.

To output digital 
signal, select DO00.

This time, set [IO] column to [out] to output by this switch.
Click [IO] column and select [out] from the list.

With the switch selected, click on the switch again to change it ON / OFF.
When it is ON, the signal is output.
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★Sample monitoring screen
You can create and monitor the system configuration diagram by 
combining various items.
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3.5. Task control functions (CONPROSYS VTC)

★What is Visual Task Control feature

Capture digital 
input value from 

the controller        

Is captured 
value 1?

Set output value to 
the controller

Set 1 to 
output area

Set 0 to 
output area

VTC is a function to process or control the controller by arranging 
items like flowcharts.
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★Task Edit screen

A Task Edit screen will appear in another tab.

In Task Edit screen, you can easily control  Tasks by placing prepared items. 
There is no need for programming languages or for a special development 
environment.

Launch Task Edit screen

Select [Task Edit] from the menu.
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★Configuration of Task Edit screen
Like the monitoring screen, select items from the left part 
selection area and place them on the screen.

On top of the screen, there is a menu bar to save, read and debug settings.

Item details can be set in the property area on the right 
side of the screen.

File

New Task

Open Task..

Save Task..

Open from 
local disk..

Save to local 
disk

Save settings 
to ROM

Edit

Undo

Redo

Delete

Cut

Copy

Paste

View

Status..

Debug..

Option

Link 
settings..

File settings

Help

Help

Version 
Information

Comments can be attached to each item in the lower right 
of the screen.
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★ Task Edit overview
You can arrange items into a flowchart on the Task Display screen in order 
to perform condition judgment and control.
You can create up to 20 tasks*. There are 2 types of tasks: main tasks and 
sub tasks.

★

Each task consists of 96 panels (8  x 12). Arrange items in these panels.

• There are 10 tasks from Task00 to Task09.
• Each task is run independently.Main task

• These tasks are run when called from a main task.
• The main task will not perform the subsequent processing 

until the sub task finishes.
• You can create up to 10 sub tasks from Sub0 to Sub9.

Sub task

Each task is run starting from the screen's upper-left panel. 
(Indicated with the star in the figure on the left.)

Items have a ▼ mark, which indicates the next item to run. When the processing 
of a positioned item is finished, the task proceeds in the direction of the mark, and 
the next item is processed.

Some items have multiple ▼ marks.
These items are used to fork the processing of the task according to conditions.

* Ver.3.2.0 or later
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★ TAG types

• Saves a numeric value
• Can be referenced from the monitoring screen
• Shared with other tasks

TAG

• Saves a numeric value
• Only valid within the local taskLTAG

• Saves a character string
• Shared with other tasksSTAG

• Saves a character string
• Only valid within the local taskLSTAG

Numeric 
values

Character 
strings

TAGs are like boxes that save numeric values and characters.
In scripting, numeric values and characters are saved to, read from, and written to TAGs.

The following 4 types of TAGs are available. 500 of TAGs / STAGs (from 00 to 499)*
and 100 of LTAGs / LSTAGs (from 00 to 99) are available.

TAG
(500)

Task00

Monitoring screen

STAG
(500)

Task00

Task19

：

LTAG (100) LSTAG (100)

LTAG (100) LSTAG (100)

LTAG (100) LSTAG (100)

LTAG (100) LSTAG (100)

LTAGs and LSTAGs are unique to each task, so LTAG00 of Task00 and 
LTAG00 of Task01 are different. ("L" means "local.")
TAGs and STAGs are shared between all tasks. Changing these values 
in Task00 will have an effect on all other tasks.

Only TAG values can be referenced from the monitoring screen.
If data needs to be displayed, write it into a TAG.

* Ver.3.2.0 or later
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★Item types and functions (input/output)
Icon Name Description

Input Input the value from the device interfaces such as analog 
input or digital input to the specified TAG.

Output
Output the value to device from the specified TAG.
It is used for ON / OFF of digital output and control of analog 
output.

Input string Input the string from the specified LINK to the specified 
STAG.

Output string Output the string from the specified STAG to the specified 
LINK.

Input Modbus This control is only available in the M2M Gateway series.
Input the value from Modbus to the specified TAG.

Output Modbus This control is only available in the M2M Gateway series.
Output the value from the specified TAG to Modbus.

In FANUC CNC

This control is available only for products that support 
FANUC CNC.
Input the value from CNC of FANUC to the specified TAG or 
STAG.

PLC R/W Trigger This control is only available in the M2M Gateway series.
Executes reading / writing of the specified PLC device.

Device status
Read the device status to specified TAG. 
It is 0x100 (hexadecimal) during operation, and stop is 0x00 
(hexadecimal).

System Info Read the system information to specified TAG or STAG.

http://data.conprosys.com/help/task/V1/en/102_input.html
http://data.conprosys.com/help/task/V1/en/103_output.html
http://data.conprosys.com/help/task/V1/en/104_strin.html
http://data.conprosys.com/help/task/V1/en/105_strout.html
http://data.conprosys.com/help/task/V1/en/10u_modbusin.html
http://data.conprosys.com/help/task/V1/en/10v_modbusout.html
http://data.conprosys.com/help/task/V1/en/110_cncin.html
http://data.conprosys.com/help/task/V1/en/111_plctrg.html
http://data.conprosys.com/help/task/V1/en/107_dstat.html
http://data.conprosys.com/help/task/V1/en/10z_sysinfo.html
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★Item types and functions (calculation, flow control)

Icon Name Description

Calculation Calculates the two TAG values.

Calc constant Calculates the fixed value and TAG value.

Set constant Set constant value to the specified TAG.

Calc formula You can define an equation, and stores the calculation result in 
the TAG.

Determine

Conditional branch.
The condition is judged with two TAGs or TAG and an arbitrary 
numerical value.
Branching occurs when the condition is satisfied or not.

Determine (Str)

Performs a comparison on the specified STAG.
We make condition judgment with two STAGs or STAG and a 
arbitrary character string.
Branching occurs when the condition is satisfied or not.

Jump
Transfers processing to the position of the specified label.
Also, if you specify [Return], the process returns to the 
beginning of the task.

Label
Create a label.
You can set the label number. Use it together with [Jump] 
items.

Noop No processing.
It is used to connect items and items.

Subroutine
Call a subroutine.
It returns by using the return of the [Jump] item in the 
subroutine.

http://data.conprosys.com/help/task/V1/en/108_calc.html
http://data.conprosys.com/help/task/V1/en/109_fcalc.html
http://data.conprosys.com/help/task/V1/en/106_fset.html
http://data.conprosys.com/help/task/V1/en/114_formula.html
http://data.conprosys.com/help/task/V1/en/10a_check.html
http://data.conprosys.com/help/task/V1/en/10b_strcheck.html
http://data.conprosys.com/help/task/V1/en/10c_jump.html
http://data.conprosys.com/help/task/V1/en/10d_label.html
http://data.conprosys.com/help/task/V1/en/10e_nop.html
http://data.conprosys.com/help/task/V1/en/10f_sub.html
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★Item types and functions (time, string operation)
Icon Name Description

Timer Branch execution at the specified time.

Calendar Branch execution at the specified date or day of the week.

Wait Delay execution for the specified time.

Calc String

Store the result of an operation on a character string in the 
specified stag.
You can manipulate strings such as combining two strings, 
cutting out some, and converting uppercase and lowercase 
letters.

Add FixedStr Store the specific character string into the STAG, such as 
newline or time.

Str2Num

Convert the character string in the specified STAG to a 
numeric value.
You can convert string length and ASCII characters to 
numbers or convert them to binary.

Num2Str Convert the specified TAG to a character string.
You can convert numbers to hexadecimal or decimal strings.

Split String
Split a character string at separator positions.
It is used to split character strings such as comma separated 
values.

http://data.conprosys.com/help/task/V1/en/10g_timer.html
http://data.conprosys.com/help/task/V1/en/10h_calendar.html
http://data.conprosys.com/help/task/V1/en/10i_wait.html
http://data.conprosys.com/help/task/V1/en/10j_strcalc.html
http://data.conprosys.com/help/task/V1/en/10w_strfixed.html
http://data.conprosys.com/help/task/V1/en/10k_str2num.html
http://data.conprosys.com/help/task/V1/en/10l_num2str.html
http://data.conprosys.com/help/task/V1/en/10m_strsplit.html
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What is the Link setting?
This setting is used to perform serial or Ethernet communication.
Click "Link" on the menu at the top of the screen to display the setup screen.
You can create up to 10 settings.

★Item types and functions (communication)

Detailed setting of communication link.

Icon Name Description

Connect
Communication link open / close.
Link connection / disconnection of the serial 
communication / Ethernet communication set by Link.

FIT Protocol
Send or receive data using the F&eIT protocol.
Send and receive using the F & eIT protocol.
Link setting is done by link setting.

Cloud

Transmit a file to Web server.
Send the file to the web server.
Specify the destination in the setting menu [Data 
Transfer]

Send Azure IoT
Transmit a file to Azure IoT Hub.
Send the file to Azure IoT Hub.
There is regulation in the file format. Please be careful.

Send Mail
Send a mail.
Send a mail to specified destination.
It is possible to attach a file.

FTP (Put)

Transmit a file to the FTP server.
Send the file to the FTP server.
The setting of the FTP server to be connected is 
specified by the setting menu "FTP".

FTP (Get)

Receive a file from the FTP server.
Receives the file from the FTP server and overwrites it in 
the target file.
Wait without proceeding to the next step until reception is 
completed or an error occurs.

http://data.conprosys.com/help/task/V1/en/10n_connect.html
http://data.conprosys.com/help/task/V1/en/10o_fit.html
http://data.conprosys.com/help/task/V1/en/10p_cloud.html
http://data.conprosys.com/help/task/V1/en/10x_azure.html
http://data.conprosys.com/help/task/V1/en/10y_mail.html
http://data.conprosys.com/help/task/V1/en/112_ftpsend.html
http://data.conprosys.com/help/task/V1/en/113_ftprecv.html
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★Item types and functions (file)

About files
The store location of each file can be set from the menu below. If you use an SD card, 
please change the setting. When the file size is set, once the file became that limit, 
oldest data will be removed and the new data will be added at the last of the file.

Note that the file disappears when restarting or 
turning off the power if Ram is the save destination.

Icon Name Description

Logging

Store collected data in the file.
Add the data of TAG (numerical value) to the 
specified file.
Also, it is possible to write dates and times and line 
feeds.

Logging(Str)
Save string in file.
Writes an arbitrary character string or the value of 
STAG to the specified file

File read Obtain data from file.
One record is read from the specified file.

File operation Log File Action.
You can copy, merge and delete specified files.

http://data.conprosys.com/help/task/V1/en/10q_log.html
http://data.conprosys.com/help/task/V1/en/10r_strlog.html
http://data.conprosys.com/help/task/V1/en/10s_fread.html
http://data.conprosys.com/help/task/V1/en/10t_fope.html
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★Basic operations - adding items -

★Basic operations - moving and deleting items -

In the same manner as the monitoring 
screen, select the item, and then click the 
location on the screen where you want to 
position the item.

You can move an item by drag and drop.

To delete an item, click to select and press Delete key, or select 
[Delete] from right click menu.

Undo ：[Ctrl]+[Z]
Redo ：[Ctrl]+[Y]
Delete ：[Delete]
Copy ：[Ctrl]+[C]
Paste ：[Ctrl]+[V]

Some operations are possible by shortcut keys.
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★ Basic operations - setting items
Setting of an item can be done in Property area.

The settings of the item will be displayed.
The setting item differs depending on the item.
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Please [Save the settings to ROM] securely.
If you reboot or shutdown the controller without [Save the settings 
to ROM] operation, the changes will be lost. [Save Task] is 
temporary saving during power on of the controller.

★Basic operations - Saving tasks -
To save a Task, please select [Save Task..] from [File] menu, and 
choose the location.

"Savie the settings to ROM”
It is possible from [File] menu of Task Edit screen.
Or you can save settings to ROM by clicking [Exit] menu in 
the main menu.

Also you can save the setting file into your PC. By selecting [Save to 
local disk], you can download the setting of current editing Task.

■Task Edit screen ■Main menu

[Save and Reboot], [Save 
and Shutdown] perform 
rebooting or shitting down 
after saving process.

Without this operation, rebooting or power off will discard the 
changes and the controller runs with the former settings. 

If you move to the other page without saving the page, the setting will be lost. 
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★ Backup and restore settings
You can output the details you have created with the scripting function or 
the monitoring function as well as the CONPROSYS settings (such as the 
IP address) as a setup file. You can also apply an acquired settings backup 
file to the CONPROSYS.

(1) [Backup] operation

(2) [Restore] operation

You can download setting file from 「config.dat」 button.

Click [Browse] and choose the backup file of the setting.
Click the [Update] button to execute the restore.
Please execute [Save and Reboot" operation to reflect the restore contents.

Saving to ROM is necessary.
After the restore operation, restore contents are reflected by saving 
the setting to ROM and restarting it. If you do not save, you will lose 
the restore contents at reboot.

Operation screen
By clicking [Configuration File] in Maintenance men, operation 
screen below will be displayed.

Get a setting 
backup.

When you click Browse, a dialog 
is displayed. Select downloaded 
backup file, and click "Update" 
button.



73

★ Digital output control
Create control so that the digital output is ON when the digital input is ON.
Create the following flowchart.

Is TAG00 ON?

Set digital 
output 0 to 
OFF.

Check

ON

Set digital 
output 0 to 
ON.

OFF

Loop

Assign digital 
input 0 to TAG00.

Digital signal input

Digital signal output

ON
ON

The equipment that has been prepared for practice is connected as shown below.

ー ＋ ー＋

DO0

Lamp

DO1

Power supply
24V

0 1 2 3
MCOMNC

DI/CNT

Switch *Old models

In this example, it is assumed that the switch 
and the lamp are connected as shown below.
・A switch for DI0
・A lamp for DO0

BCOMACOM

Switch 
*OPC models and new models
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★Digital Output step 1 : Assign a device value to TAGs

Select TAG00 as Tag ID, a Tag storing the value.
Please select from the tree displayed when 
clicking.

Place [Input] from the parts selection area to the 
top left square.
Since [Input] is selected after placing, the setting 
item is displayed in the property area.

Select DI00 from the tree.
Then input status of the switch, DI00, will be 
stored in TAG00.

Digital signal input
LTAG00

ON: 1
OFF: 0

When the switch is ON, the bit is 1. 
Otherwise, the bit is 0.

Use TAGs to handle data in task programs.
TAGs like that shown below are available.
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Condition setting of [Determine]
This time we made the condition of TAG 00 = 1, but on the contrary it is 
also possible under the condition of TAG 00 = 0.
In this case, the condition will be reversed.

★Digital Output step 2 : Assign a device value to TAGs

Next, place [Determine] to judge the value and branch the process.

Please set properties as shown left.
The judgement condition is as follows;
IF TAG00 is 1 then go down, else go right.
In the [Input] process, the switch state is 
stored in TAG00. If the switch is on the 
value becomes 1, and if it is OFF the value 
is 0.

Place [Determine] to the 
destination cell of the 
arrow of [Input].

If the switch is OFF, go right. 
(condition is not established)

If the switch is ON go down. 
(condition is established)

If Digital signal is ON, go right. 
(condition is not established)

If Digital signal is OFF, go down. 
(condition is established)
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★ Digital Output step 3 : Checking operations
You have created the flowchart up to the conditional branch when the 
button is on, so next check that operations are performed correctly.
The process will proceed to the squares where no items are placed, 
so let it return to the first square by [Jump] Item.

To check operation, please select [Debug..] from [View] menu.

Click [Debug run] button, 
then it works.

[Jump] is the item that moves process flow to the specified [Label]. You can select 
[Return] as a destination. [Return] moves the process to the first square, top left.

Set the destination in 
Property area as [Return].

Set the both destinations.
Now it proceeds repeatedly.

Add Jump

Before checking the operation, you need to save changes. Click [Save 
Task..] from [File] menu.

Save to Task:0.
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After checking the operations, click "Stop" to stop debugging.

Task Status
The status of Tasks can be shown from
[View] – [Status..].

Run : Running
stop : Stopped
debug wait: Executing debug

The cell in execution is highlighted in green.

The process branches according 
to the switch state.

ON

Debug information is displayed.

During debug process, the cell in process is highlighted in green.
And the operating speed is reduced.

OFF

ON

OFF

You can see it changes the route according to the state of the switch. 
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Is TAG00 ON?

S   
o    
O

Check

ON

Set digital 
output 0 to 
ON.

OFF

Loop

Assign digital 
input 0 to 
TAG00.

★ Digital Output step 4 : Output Digital Signals
We finished checking condition branch.
Next we will output a digital signal to lit a lamp.

Place [Set Constant] to the destination when switch is on.
Put 1 to TAG01 in [Set Constant].

Add [Output] from TAG01.

Set the digital output DO00 to ON by writing TAG01 we 
set to 1.

Set property items as below.

Now you can set DO00 to ON by turning ON the switch.

Add Output

We want to add items after the point where the 
switch is set to ON, so move the [Jump] item at 
the destination of the condition judgment.

Drag and drop the [Jump] item down by two cells.
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Now, when you set the switch to ON, the digital 
output will also be set to ON, and the lamp will light.
When you set the selector switch to OFF, the lamp 
will turn off. Save the setting and try it.

Selector switch Lamp

Digital input (DI00)

The switch and the lamp are linked.
Digital Output (DO00)

★ Digital Output step 5 : Turn OFF Digital Signals
Add control to turn OFF the output of the digital signal when the switch is turned OFF.

Just as before, drag & 
drop the [Jump] 
position to the right.

Place [Set Constant] to the right side of [Determine].
Last time we set 1 to TAG01 to turn ON, now set 0 to turn OFF.
And select [Right] for the [Next step].

Then place [Output] next to [Set Constant].
Turn OFF the output by writing TAG01 we set to 0.
Settings of the property items are shown below.
Select [Right] for the [Next step] to connect to [Jump].
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★ Digital Output step 6 : Optimize locations
In some case, you can build a task with fewer items.作ったタスクをよく見ると、
There are two same setting used in this sample.

Same

Same

As in the sample right side, the new layout reduced 2 items by 
arrangement and changing directions.
This method is useful to save using cells. But considering 
readability or separating a task in two tasks or subroutines are 
important to layout.

If the process becomes complicated, you can add comments to 
items to see it easily later on.
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★Task Script function example 1 : Save files
This is an example to save a file in RAM by using save item.
In this case, it saves data from Analog Input (AI0) to a file in every second.

Analog Input（AI0)

First, place [Wait] and set 1 sec [Wait time].

Next, place [Input] to set Analog input (AI0) to a Tag.

The 0 ch of Analog input is AI0.

Wait 1 second

Set the Analog Input (AI0) into TAG00

Add TAG00 data to File00

Wait 1 sec.

Set AI0 to Tag00

Add Tag data to a File

Process flow is as below.

Set to 1 
second.

Wait 1 sec.

Set AI0 to Tag00

Add Tag data to a File
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Next we write a file.
In this example, we create the following file format.

Date Time Analog Data New line

Date Time TAG00 CR+LF

The actual file will be a CSV file as shown below.
2016/05/23,12:04:14,0,

Finally return with [Jump] and repeat 
the process.

We use [Logging] to write a file.
In this example, we write to File00.

To write the date, specify 
[Date] for [Value].

Write the file by arranging [Logging] in 
the same way.
To write the time, specify [Time].
Analog input data is stored in TAG00.
Use new line (CR+LF) at the end of line.
Then one line data was written.

Wait 1 sec.

Set AI0 to Tag00

Add Tag data to a File
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As the factory default, it continues to append the file to the RAM, limit the file size.
Select the [File setting] from [Options] and set the size of File 00 to 1 Kbyte.

Let's actually operate the created process. Please save the task from [File] menu.
[Run task after saving] is checked, it will automatically operate.

* The Ram file disappears when restarting or power off, so if you want to 
keep it please save it to SD. (Insert the SD card in the controller)
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The created file can be confirmed from [File View] in Status menu.

1 Select File View

2 Select [Task RAM Folder] from list.

3 Click [Get] button.

By clicking the file name, you can download the file.



85

Wait 1 sec.

Set DI00 to TAG

Check change of TAG

Wait 1 second

★Task Script function example 2 : Create history file

An example of processing to record changes of digital signals in a file by the task 
script function. In this example, we will create a file in RAM.

Next, read digital input (DI00) into TAG00.

This time check the signal every second.
At first wait 1 second.

Set the Digital Input (DI00) into TAG00

Check change of signal

No operation

Not changed

Changed
Write to File00

Update last status (LTAG00)

Wait 1 sec.

Set DI00 to TAG

Check change of TAG
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To check the change of digital signal, compare with the former value.
In this example, we store the last time value in LTAG00.

Compare digital signal (DI00) with the last value.

Judgement condition is as below.
Test TAG00 ＝ LTAG00 ?
Established (Not changed) : No operation
Not established (Changed) : Write file

If condition is established, no process required. Place [Jump] to return.

Return to top and repeat

TAG00 : Current state
LTAG00 : Last state
Record to file when these 2 tags not 
match. 

Check change of signal

No operation

Not changed

Changed
Write to File00

Update last status (LTAG00)

Check change of signal

No operation

Not changed
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In case of a change of the signal, we check whether the current value is 0 (OFF).

Write the process when the current value is 0 (OFF).
First of all, write the date and time at the beginning of File 00. We use two 
Log items, [Date] and [Time].

Write to File00

Create a process when the digital signal changes.
The details of the contents written to the file will be as follows.

Check current digital signal

Write a message of “OFF”

Write a message of “ON”

０（OFF)

1（ON)
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Add a message to keep as history when the digital signal is OFF.
Set the message using [Logging(Str)].

We also create a history when the signal is ON. 
In the same way, set Date and Time by [Logging] and create a 
message for ON with [Logging(Str)].

Append new line (CR+LF) at the end of the file.
This will be done both state. So we placed as below.

Then a CSV file formatted as;
Date, Time, Message, (new line).

Write an arbitrary message in the item of the string 
and write it to File00.
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Finally update the last time value (LTAG00) by [Calc Costant].

Finally, add [Jump] to return, it is completion.

Check the task RAM folder from [File 
View], a file is created.

Update the last time value (LTAG00) 
to current valueを現在値(TAG00).
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Wait 1 second

Set the Digital Input (DI00) into TAG00

Check change of signal

No operation

Not changed

Changed
Write to File00

Update last status (LTAG00)

★Task Script function example 3 : Mail alarming
As an application of task script function example 2, it is possible to send not only 
history but also e-mail.There is no change in the basic logic, add [Send Mail] icon 
after writing the signal state. For mail transmission, not only the icon but also the 
server setting etc are necessary.

Send mail

Sending mail is 
possible by adding 
[Send Mail] icon 
and [Mail settings].

Send mail 
function
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For checking server setting, a test 
mail sending is possible.

In order to send a mail, it is necessary to set the SMTP Server (mail 
server) to use when sending mail and the e-mail address to send e-
mail. The setting method of each is shown below.

★Task Script function example 3 : Mail setting

Set using mail server 
information, Server address, 
Port, Sending user and 
password.
Setting of mail sending by 
CONPROSYS.
1. Test Mail Result Type
Setting for result display.
Choose from Result only, 
Messages etc.

2. Retry interval, times and 
number of keeping resend 
mail
Retry interval and times in 
case of send error is 
possible.

You can set SMTP Server and Mail address from [Mail] in Setting menu.

1. SMTP Server setting

2. Mail addresses setting.

Addresses can be concatenated with 
comma, and 10 entries are available.
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Please use “Add FixedStr" when you want line breaks in the text. 
In addition to [CR + LF], Date etc. can be inserted.

★Task Script function example 3 : Send Mail item overview

1 To/CC/BCC

Destination address. The message will be sent to the mail 
addresses set in Mail Address setting.

2 Subject/Body

The subject and message body. Although it is possible to directly 
enter this property, [STAG] / [LSTAG] can also be used.

3 Attachment

You can attach a file when send mail.

1

2

3

You can perform the mail transmission by performing the above-
mentioned Mail setting and using [Send Mail] item at the task.
The outline of the mail sending icon is shown below.
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CONPROSYS HTTP transmission function

★Task Script function example 4 : Data transmission

This is an example of data transmission by using Task Script.
In this example, we use Data Collection Software for PCs.
Please refer to Chapter “4.1. Data Transfer function” for detailed 
installation instruction of Data Collection Software.

We use below network configuration.

Controller
IP:10.1.1.101

PC with Data Collection Software
IP:10.1.1.200

Ethernet (LAN cable)

CONPROSYS has 2 types of http(https) transmission function.
Since these functions can not be used simultaneously, please switch it 
on your application.

1. Automatic Data Transmission function
This function captures interfaces of CONPROSYS such as DI, AI, DO 

and others and send to Server, cloud or on premise, every minutes. 
This service can be enabled/disabled in [Data Transfer setting]

2. Data transmission by Task Script
[Cloud] icon in Task Script sends CSV file to the server.
You could use this to shorten sampling interval etc.

We explain how to send data by Task Script after this.
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The destination of data transmission is set by [Data Transfer] 
setting.
The data will be sent to the specifies URL.

Setting of the destination URL is as below.
Ex. When IP address of the Data Collection server is 10.1.1.200,

set http://10.1.1.200/PostData.php.

Data Transfer setting

★Setting the destination
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Because we send data by Task Script, disable Data Transfer Service.

Service setting

To send data in Task Script, please use [Cloud] icon.
You only need to specify the sending file.
Please refer to example 1 and 2 above to create the file.

Even if cloud transmission is performed at very short intervals, processing 
may not be completed in time. For example, when sending measured data at 
1 second intervals, please create a mechanism to record data every second 
in a file and send data for 10 seconds when it gets for 10 seconds.

★Supports FTP transmission
In Task Script, FTP client function is also supported.
In the same way as [Cloud] function, you can designate a file with the 
[FTP(Put)] function and send the file to the host system.

When you set [Enable], 
automatic Data Transfer send 
the data. In that case, you can 
not send data by Task Script.



96

★Task Script function example 5 : Exception Handling
You can capture system and service status into 
TAG, and can see/check it in VTC/HMI.

By using this function, you can notify or log the exceptional event to 
confirm operation status and to solve an issue. 。

System info 
capturing

TAG

Task Script (VTC)
・Log alarm condition
・Notify alarm condition
・Build exception process

HMI Function
・Create status 
monitor screen

System information
・Result of service
・Communication state
・Current time
..

You can assign various 
information of CONPROSYS 
to TAGs.

We think that you can use it 
in various forms, such as 
getting the NTP sync. result 
and stop the task until it is 
synchronized, saving the 
date of failure to send to 
the server in the log or 
displaying it with HMI.
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CONPROSYS VTC Script sample programs
There are many useful samples of Task Script in our website.
You can download backup file of a Task Script.
https://www.contec.com/products-services/daq-control/iiot-conprosys/software/script100/

It contains text file for explanation and backup files of Task and  
Subroutines so you can refer to create your tasks.
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VTC Script sample：Apply backup file
In Task Edit screen, select [Open from local disk..] from [File] menu.
In the dialog, select the downloaded configuration file and open it.

Then the Task will be displayed.

Depending on the sample type there are multiple backup files.
Also, please make sure to match the backup restore destination number. 
Especially when the subroutine numbers are different, it is necessary to change 
the number of the subroutine call.

Please refer to Readme file in downloaded file.
In this example, restore the subroutine to SUB9 as explained below.
> [Description]
> The sample program has a main task (TASK9) and a subroutine (SUB9).
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★Firmware update
You can update firmware of the controller from web browser.
Version Up patch file can be downloaded from our website.
You can update software remotely if you can access the controller via 
network.

Upload Version Up file

Update

3.6. Other functions

Click [Browse..] to select the file.
A dialog will appear. Select downloaded 
update file and click [Update] button.

The downloaded file is compressed by ZIP format. Decompress 
it and use the bin file extension. 
ST1 and ST2 LEDs continue to flash while upgrading. Rebooting 
will start automatically upon the completion of upgrading. 
Check whether the version has been promoted in the [Status] 
menu.
Note: the updating process may take more than 40 minutes.
Please do not turn off the power to prevent unexpected defect.
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MEMO



4. Linking with External Systems
M2M/IoT Solution

M2M/IoT Solution
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4.1. Linking with External Systems
★Overview

CONPROSYS can link with external systems in various styles.
In this chapter, we explain linkage and settings to link with external 
systems.

External Linking Functions

* In this chapter, we introduce Data Transfer function and Microsoft 
Azure linkage. Please refer to Chapter 2 for the other functions.

• Data transfer function
The collected data is periodically transferred over HTTP or HTTPS.
In addition, FTP data transmission is supported (Ver.2.5.0 or later.)

• Modbus slave function
CONPROSYS controller has Modbus/TCP slave function. You can acquire 
the controller status information from an external device over Modbus/TCP.

• OPC-UA & MTConnect communication function
We offer models that features OPC-UA Server and MTConnect function.

• Linking HMI sofware
Modbus and OPC UA communication enables linking with HMI / SCADA 

software.

• Linking the Microsoft Azure
It is possible to link with the Cloud service provided by Microsoft Corporation.
Although cooperation using SDK is also possible, CONPROSYS can realize 
Azure linking by using standard functions.
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4.1. Data Transfer Function
★ Data transfer function settings overview

Host system

Data transfer function

Measured 
data

These settings are used to transfer the data collected by the controller to the host 
system.
You can transfer data just by setting the URL of the host system and the data transfer 
interval.

A

S

Actuator

Sensor

A
S

http://www.XXX.com

To transfer data to the server, click [Data Transfer] in [Setting] menu, and 
then configure the settings.

Also note that in order to perform the data transfer, you have to configure 
the Time Synchronization settings and enable the data transfer in the 
Services settings.

■ Data transfer settings
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★Overview
By using our managed cloud server, you can accumulate the data files of the 
controller, and can browse and download through the web browser. It also has a 
function enabling cooperation with an external server. It has functions that can be 
expanded from a small start system to a large scale system in the future.
* Commercial version of the service is available in Japan only.

4.2. CONPROSYS Cloud Data Service

CONTEC
Cloud Service

Internet

Check and download data of 
equipment via Web browser.

End User

External Cloud servers

CDS information can be 
acquired from an external 
server. It is possible to use 
CDS as data HUB.

Image of Cloud Data Service

・Data storage / aggregation
Store captured CSV data file into a database.
Create daily / monthly / annual reports based on minute data.

・Data processing
Process and manage collected data from controllers.

・Simple graphs and lists
Data collected can be viewed with simple graphs and lists.
Easy configuration of Top Monitor layout and Graph contents.

・Alarming
By setting thresholds of measurement data, alarm mailing and logging abnormal 

history are possible.

・User management
ID / password management of administrator and viewing user.

・External data linkage
We provides Web API which allows external servers to extract data from our 

Cloud Data Service server. For more details, please contact us.

Cloud Data Service functions
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★Cloud Data Service screen configurations
Below is the screen configuration of CDS. Administrators can view and change the 
management screen. The management user and the viewing user are identified 
using the ID at the time of login.

Screen configurations

Login form

Unit List

Top Monitor

Measurement List

・Minute
・Hourly
・Daily
・Monthly

・Minute
・Hourly
・Daily
・Monthly

Error Threshold History

User Maintenance

Unit Master Maintenance

Site Master Maintenance

Measurement Data Definition

Calculation Maintenance

Summary Maintenance

E-Mail Maintenance

Communication Blackout History

General (Unit)

Administer

Summary List

Measurement Graph

XXX

XXX ：Screen

：Category

Calculation Top Monitor

・Minute
・Daily
・Monthly

・Minute
・Daily
・Monthly

Calculation Summary List

Calculation Summary Graph

General (Calculation)

Calculation Measurement List

Data Keep Maintenance

Data Delete

Billing Reference History

Other
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★Coud Data Service screen images
Followings are each careen images of CDS.

■Login form
Login screen to the server.

■Unit List
Screen displayed after login.
Possible to confirm communication status and to select viewing 
unit.
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■Top Monitor
Screen displayed after selecting the unit. Customer can change 
layout, add texts and change text colors etc.

・Example screen 1

・Example screen 2
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■Measurement List
Can display collected data in a table or a graph.
Customer can select displaying data.

・Table

・Graph
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■Setting screens
In addition to data collection / display settings, it has various setting 
screens such as user management and mail transmission. This screen can 
be viewed only by administrative users.

・Measurement Data Definition
It is possible to perform processing of the collected data and screen display setting.

・User Master Maintenance
User account setting is possible.

・E-Mail Maintenance
Setting of destination mail addresses 
for alarm mail.
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★Overview
By using Data Collection Software, it is possible to store CSV file data 
sent from controllers.

Data Collection 
Software

Data Transfer function

Measurement 
Data

A

S

Actuator

Sensor

A
S

CSV
CSV

Please download the Data Collection Software from our website.
https://www.contec.com/products-services/daq-control/iiot-conprosys/software/

Installation of Data Collection Software

4.3. Data Collection Software
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Following the instruction in README, move the extracted two folders to C drive.
C:¥Apache22, C:¥php

Run Apache22¥bin¥httpd.exe in the moved folder.
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Since security warning may be shown when executed, check according to the 
environment and allow access.

Below screen will be appear when it start normally.
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★NTP Time Synchronization
To send data, Time synchronization and Enabling data transfer are required.

After changing the setting, be sure to save the setting to ROM by the 
"Save" operation and perform restart.
If time synchronization is not established, data transfer can not be performed.
You can check from "System Information" whether time synchronization / data 
transfer is being performed or not.
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Azure is a cloud solution aimed at facilitating collecting and analyzing 
general-purpose data provided by Microsoft. Our M2M controllers are 
certified as Azure Certified Device.

Microsoft
Azure

Measurement 
Data

CONPROSYS is listed in Microsoft’s website as Certified Device that has 
been finished connection test. The connection is described in next page.

Azure Certified Device

Microsoft Azure

★Overview  - Efforts for Azure -

0 1
1 0

Blog storage

Event hubIot hub

Collect

Store

Power BI

Analysis, Visualize

4.4. Linking Microsoft Azure

Certified for IoT Device Certification
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• Azure IoT Hub setting
• Build sending Task

There are 3 steps to send data to Azure.

In this section, we will introduce only "STEP 2 controller setting".
For details of STEP 1 and STEP 3, please refer to the software manual of the 
product, or to the Microsoft company HP.

★Data transmission to Azure with VTC
Azure Data 

transfer

STEP2
Controller Setting

• Check by Device Explorer
• Data check on Azure

STEP3
Check settings

• Acquire Azure account
• Setting of IoT Hub, 

connection string

STEP1
Azure General 

Setting
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Perform connection setting of Azure IoT Hub to send data to Azure.

Setting is done through [Azure IoT Hub] from Setting menu.

★Linking Microsoft Azure – Controller Setting -

Connection String
The connection string is a character string required for the 
IoT device to connect with the Azure IoT HUB. The summary 
of the acquisition procedure is shown below.

1. Create a Microsoft Azure account

2. Creation of Azure IoT Hub

3. Obtain Primary key on Azure IoT Hub
* A unique character string is generated for each created IoT
HUB.

4. Download / install "Device Explorer" tool
* It is software that runs on Windows PC.

5. Create device connection string using "Device Explorer"
By extracting the Primary key of IoT HuB acquired in 3. on 
"Device Explorer", you can acquire a connection string.
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To send data to Azure, use [Send Azure IoT] icon.

This control can send CSV file created in CONPROSYS to host system 
similar to [Cloud] icon in Chapter 3. By using this icon, it sends CSV 
file with converting it to JSON format.

★Linking Microsoft Azure – Build a Task -

Format Example data

CSV file

JSON 
Data

Item Line
Record data 1
Record data 2

：
：

Date,Time,ID,Temperature,
2016/11/22,10:00:00,1,17,
2016/11/22,10:10:00,2,18,
2016/11/22,10:20:00,3,18,

{“Date”:” 2016/11/22”,”Time”:” 10:10:00”,ID”:” 2”,Temperature:”18”}

{“Date”:” 2016/11/22”,”Time”:” 10:00:00”,ID”:” 1”,Temperature:”17”}

{“Date”:” 2016/11/22”,”Time”:” 10:20:00”,ID”:” 3”,Temperature:”18”}

{Record data 1}

{Record data 2}

：

：

Send specified file to Azure IoT Hub with converting to JSON format.
The first row is list of item names, and the 2nd and subsequent rows are data.
Comparison of CSV file format and JSON format example data is as below.

Not that the header, the item name list, is necessary.

◇Transmission format
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Following is an example of Azure IoT sending Task.
Please note the item names are necessary in the first row.

★Linking Microsoft Azure – Build a Task -

Wait 1 minute

Append data to File00
・Read analog input (AI0) to TAG00
・Write date-time data to File00
・Append TAG00 data
・New line

Send to Azure and delete the file

Write item names in the 1st row of File00
・Append string [DateTime]
・Append string [AI00]
・Append new line (CR+LF)
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You can check sent data from the device by Device Explorer. 
In Device Explorer, select the device and click [Monitor]. 
Then you can see the sent data from the device.

★Microsoft Azure Linking – Check sent data -
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★Reference : Microsoft Azure Linking by SDK
You can also connect to Azure by using CONOPROSYS SDK.
In this case you use as a Linux box without using our standard 
software.

• Make boot SD
• Device registration in Azure

STEP1
Preparation

SD

• Network settingsSTEP2
Device Setting

• Programming
• Build & run

STEP3
Build & Run

SD Boot SD
・We provide the SD image 
file in our website

Serial cable

Azure

Perform network setting of CONPROSYS from a 
terminal software.

Azure

We provide a 
sample.

・Send measurement 
data to cloud

Serial cable
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6. Support Information

We have prepared a support system to enable users to use CONTEC products 
with peace of mind.
For outside of Japan, please contact to our subsidiaries or local offices for sales, 
technical and maintenance services.

[Japan] Head Quarters
3-9-31, Himesato, Nishiyodogawa-ku, Osaka 555-0025 JAPAN
TEL +81-6-6477-7861 FAX +81-6-6478-1031

[EMEA] Amsterdam Branch
Strawinskylaan 1249, 1077XX Amsterdam, The Netherlands
TEL +31-20-238-0960 FAX +31-20-238-0969

[Americas] CONTEC AMERICAS INC.
3991 Sarno Road, Melbourne, FL 32934 U.S.A.
TEL: 1-321-728-0172 FAX: 1-321-722-2216

[China] CONTEC (SHANGHAI) CO., LTD.
Room 1002, Qilai Building, No. 889, Yishan Road, Xuhui District, Shanghai 200233 CHINA
TEL: 86-21-5401-2288 FAX: 86-21-5401-2287

[Taiwan] TAIWAN CONTEC CO., LTD.
9FL, No.738, Zhongzheng Road, Zhonghe District, Xinbei 23511 TAIWAN
TEL: 886-2-8227-8669 FAX: 886-2-8227-2498

[Singapore] SINGAPORE CONTEC PTE. LTD.
Blk 4010, Ang Mo Kio Ave.10 #07-01 Techplace 1, 569626 SINGAPORE
TEL: 65-6459-1667 FAX: 65-6552-6766

[Korea] Contec Co., Ltd. Korea Liaison Office
19, Cheongmyeong-ro 21beon-gil, Yeongtong-gu, Suwon-si, Gyeonggi-do, 16705 Korea

Sales offices

Technical support center
Email: tsc@contec.jp
TEL +81-50-3736-7861

Support center

Repairs reception desk
Email: sbcenter@contec.jp
TEL +81-6-6477-7214 FAX +81-6-6477-8019

Repair center

* Request repairs through the retailer where you purchased 
the product.
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